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� Alternative Methods of Organizing Material

� Workshop 4: Organize and Begin Picking Shots

The Editing Workflow
The editing workflow in Final Cut Pro is very customizable. You organize
your footage in the Browser, view clips in the Viewer, and then add them to
the Timeline or Canvas for inclusion in your sequence (your finished pro-
gram). You can edit entirely with the mouse, or you can edit entirely with
the keyboard. It’s up to you, but most editors seem to use a combination of
both. Experiment to find your optimal setup for any particular job.

Customizing the Interface
Final Cut Pro 4’s keyboard and interface mapping opens a world of pos-
sibilities. FCP 4 allows you to map virtually every menu command, key-
board command, and button in any or all of the four major windows
discussed in Chapter 3 “Understanding Final Cut Pro’s Interface: An
Overview,” as well as in the Tool Bench window. Buttons can simply 
be dragged and dropped onto the button bars located at the top of the
windows. You also can map any of the 600 commands to your 
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keyboard. Furthermore, you can save the settings of different interface layouts and
even move them from editing station to editing station. It might be advantageous to
have different layouts for different jobs, because one particular edit might not be the
same as the next.

Mapping the Keyboard
You can activate the customizable Keyboard Layout window using the Tools menu
or by pressing Opt+H. When you activate this new feature for the first time, the
default keyboard layout opens. Thereafter, it opens with the custom keyboard layout
you have set up.

Figure 4.1 shows the default keyboard layout. If you are familiar with FCP 3, the key-
board shortcuts are nearly the same in FCP 4, so don’t worry that your old keyboard
shortcuts won’t work any more. Notably, though, Redo has changed. Undo is still
Cmd+Z, but Redo is now Shift+Cmd+Z. Default keyboard shortcut layouts can always
be recalled by clicking the Reset button, so don’t be afraid to experiment.

FIGURE 4.1 The default keyboard layout window.

Setting up a custom keyboard layout is easy. The right side of the window lists the
various commands, organized by menu or category. First, unlock the keyboard by
clicking the lock button in the bottom left of the window. Then drag the icon of a
command from the list and drop it on the keyboard.

Because there are about 600 different icons, you can’t memorize them all. If you hold
the mouse over an icon that’s already mapped to the keyboard, you see a ToolTip
(small yellow box) that describes what the icon stands for.
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Notice the search box in the top right of the window. When you type a search word,
such as “audio,” any command having to do with audio is listed on the right of the
window. If you are unsure of which menu or category a certain command is in, the
search box helps you narrow down the list. What’s even more convenient is the fact
that as you type the word you are searching for, the list changes accordingly. For
example, to find all the audio commands, you really only need to type au. However,
doing so lists any command that includes a word starting with “au,” such as “auto”
for the commands that Auto Select tracks. If you type aud, the “auto” commands dis-
appear from the list. To go back to the “standard” listings, just click the X button in
the search box.

Even if you don’t change the default keyboard setup, you can see what keyboard
commands might already be built into the default setup. This is especially useful
when you repeatedly use the same command or set of commands.

You can clear the entire keyboard by clicking the Clear button in the lower right of
the keyboard display. A total rewrite of the keyboard shortcuts can be especially use-
ful for an editor who is used to different keyboard shortcuts from a different NLE
application. I found myself using Avid keyboard shortcuts early on when I was learn-
ing FCP (to no avail, of course). I might have become more productive sooner if I had
this ability then.

Notice the tabs above the keyboard layout. Clicking any of them opens another key-
board layout, allowing you to use modifier keys (such as Command, Shift, Option,
and Ctrl) in your setup. Ten different modifier keystrokes are available for mapping.
You cannot drag a shortcut from one modifier keyboard to another.

If you assign a new keystroke to a command, and it is already assigned in the current
or default setup, Final Cut Pro asks you if you want to reassign the shortcut. Any
assigned shortcut, whether a default one or one you’ve created, appears next to the
command in the list on the right.

After you have remapped your keyboard, you can save the new layout for recall at
any time on any edit station, including the present one. Select Tools, Keyboard
Layout, Export. This layout is then saved in the User>Library>Preferences>Final Cut
Pro User Data>Keyboard Layouts folder. You can recall it by selecting Tools, Keyboard
Layout, Import. You can transport this file to another FCP station. I think one of the
USB keychain-like memory devices might be just the ticket for this transportation.

Another feature available is to print these layouts. You can save a layout as a text file
by selecting Tools, Keyboard Layout, Save grid as Text. This file can then be opened
in a text editor or word processor. Because it’s a tab-delimited text file, you can also
open it in a spreadsheet program and print the layout for a “cheat sheet” that shows
you only the commands you have remapped. Pretty cool.
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Choosing the other options listed on the Keyboard Layout submenu results in 
different columns and formats for the text files created:

� Save Menu Commands as Text creates a text file that lists all the commands on
the File, Edit, View, Mark, Modify, Sequence, Effects, Tools, and Window menus.
(Choosing this option doesn’t list the command groups, such as Compositing
and Editing.)

� Save Command Groups as Text saves all commands on the Audio, Capture,
Compositing, Display, Editing, Export, Favorites, Files, Filters and Effects, Goto,
Help, Import, Mark, Other, Project, Render, Search and Replace, Settings,
Timecode, Tool palette, Tools, Transport, and Windows command groups.
Commands in the text file are listed by command group in the same order they
are listed in the Command list area. (This option does not let you save menu
sets, such as File and Edit.)

� Save All Commands as Text saves all the sets of mapped keyboard commands
(command groups and menu sets), with commands listed alphabetically.

� Key Table as Grid exports as tab-separated variables for import to a spreadsheet.

� The Menu command list is simply a list of menus and the commands and 
keyboard equivalents that are associated with them. The command is tab-
separated, so it forms its own column if it is imported to a spreadsheet (other-
wise, it would print with a gap). Organization is by menu.

� Command Groups as Text is essentially the same as the menu commands but is
organized by function, such as Audio and Compositing, instead of being based
on a menu.

� All Commands as Text organizes the information alphabetically.

The last three commands are essentially the same—a list of commands and keyboard
equivalents currently assigned, separated by a tab. All that differs is their organiza-
tion—by menu, by command group (functions), or alphabetically.

Mapping Buttons to the Button Bars
You can map the command icons to many places in the interface. The Browser,
Viewer, Canvas, Timeline, and Tool Bench windows contain a button bar at the top
right where you can add these commands. The Timeline window’s button bar
already contains two commands—the Snapping icon and the Linked Selection icon.
Clicking them activates these commands or turns on or off a condition they invoke,
such as snapping.

You can map from the Keyboard Layout window’s list of mappable commands. You
also can open a command by itself for the task by selecting Tools, Button List, by
pressing Opt+J, or by Ctrl-clicking a button bar to open the button list. The same
button list found in the Keyboard Layout window opens by itself, and the same
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search box is there as well. If you drag an icon and drop it on one of the button bars
in any of the four windows, it’s added to the button bar. To remove it, drag it off the
button bar, or Ctrl-click it and select Remove from the context menu that appears.

Figure 4.2 shows the context menu that opens when
you Ctrl-click any button. This menu allows you to
add a spacer between buttons (possibly to group
them), colorize the button (to further delineate its
category), remove it or all of the buttons in the 
button bar, open the Keyboard Layout window, 
and save or restore a button set. These files are 
much the same as the keyboard layout saves
described a moment ago. They are kept in the
User>Library>Preferences>Final Cut Pro Users Data>Button Bars folder. Button bar
layouts can be moved from station to station. Freelancers will really like this new fea-
ture. Create a CD that contains all your custom settings, and load it onto another
computer to feel right at home.

FIGURE 4.2
A button’s context menu.

Using a Multibutton Mouse
There is an enormous advantage to adding a multibutton mouse to your setup. Many
context menus are opened by a Ctrl-click (a right-click on a multibutton mouse), and a
mouse’s scroll wheel scrolls all the windows vertically in FCP 4. This enhances your
workflow tremendously. Scrolling through a Browser or bin full of clips is faster this way.

Ctrl-clicking is best accomplished with a two-or-more-button mouse. I think that the
single-button mouse is quaint, but hardly efficient. I heartily recommend a multifunc-
tion mouse for use with Final Cut Pro. There are context menus all over the interface
you can activate by Ctrl-clicking. You can get to them much quicker than with a key-
board command and a single button mouse click, and you click just once with a multi-
button mouse programmed to be a Ctrl-click. You’ll be amazed how much easier it is to
right-click instead of holding down the Ctrl key and clicking. Ctrl-clicking is akin to
right-clicking on a Windows machine, and it’s built into many Mac programs, so you’d
use it for more than just Final Cut Pro. It’s a necessity.

Organizing Source Clips
It’s a terrible thing to continually have to interrupt your creative flow because you
can’t find the clip you know will work really well. The best way to make your work-
flow fluid is to get your source clips into a manageable order. By doing so, you also
refamiliarize yourself with the source material. As you watch it, you begin to formu-
late a strategy for editorial. Some projects have very little source material and don’t
really call for a lot of organization, but projects of any length really benefit from it.
Think of editors who work with thousands of source clips! The last feature-length
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project I worked on had about 3,500 individual takes of about 1,000 different setups.
Looking for specific takes without organization would have been a waste of time.

Take a look at Figure 4.3. It’s the source footage you are about to edit. It doesn’t look
like too much to sort through, right? It’s deceiving, though. The audio clips have
some strange names, for one thing. These names are those used by the recording
facility where the audio was recorded. They were not captured from tape. They were
created as digital files and were sent to editorial with the names and audio formats
they were recorded under. So they came to the editor with odd names created by
someone else. The three large video files have pretty nondescriptive names (other
than the time-code hour that is tied to them), and they contain many shots and
more than one take of those setups. Sorting through nearly an hour of footage cut
into only three different picture clips would be a huge waste of time.

FIGURE 4.3 The open Browser window.

As in the case of this tutorial, if you didn’t shoot the source footage, you had one
look at the source material when you captured the footage or viewed the footage
once for this tutorial, but I’ll wager that although you noted many of the shots in
your memory, you can’t remember exactly which clip they are in right now. It’s time
to subclip them and organize them into bins that contain either the scenes they
belong to or a category for the type of element they are. The same can be said for the
audio files. We will begin to do this in this chapter’s workshop.
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Editing Aesthetics
No two films are exactly alike, but all of them have similarities. Everyone grows up
watching motion pictures, and we’ve become accustomed to certain conventions used in
the language of film. Hopefully, we get so wrapped up in watching a film that we don’t
notice how we are manipulated by the filmmaker. The moment an editor misuses this
language, we lose interest, or, just as bad, we get confused and lose track of the story.

What are aesthetics, and how do they apply to the art of motion pictures? The dictionary
defines this term as follows:

1. The branch of philosophy dealing with the study of values such as the beautiful
and the sublime

2. The study of the rules and principles of art

3. A particular idea of what is beautiful or artistic

4. How something looks, especially when considered in terms of how pleasing it is

Every filmmaker strives to create art, but what is art? Back to the dictionary:

1. The creation of beautiful or thought-provoking works, such as in painting, music,
or writing

2. Beautiful or thought-provoking works produced through creative activity

3. A branch or category of art, especially one of the visual arts

4. The skill and technique involved in producing visual representations

5. Creation by human endeavor rather than by nature

6. The techniques used by someone in a particular field, or the use of those 
techniques

7. The skill or ability to do something well

8. The ability to achieve things by deceitful or cunning methods

Enough of Webster. As a filmmaking storyteller, it’s your job to use all these definitions of
aesthetics. We’ll use these definitions and show, at least with this particular project, how
they apply. Hopefully you’ll keep these tenents in mind when you edit your next project.

The first of my “live and die” rules of editing aesthetics is that storytelling is paramount.
If a writer creates the story on paper, it’s the director who does the first “transfer” of the
story to motion pictures. The editor does the last rewrite of the story using pictures and
sound instead of verbs and nouns.

What keeps us involved in a good story? A good story keeps our attention; isn’t so
familiar a story that the outcome is never in doubt; keeps us entertained, possibly by
telling an older story in a fresh way; and keeps our minds on the subject at hand, not

continues
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boring us with unimportant details. There are lots of different views of editorial tech-
nique, and there are many different styles, but one that everyone can agree on is that
a setting must be established first.

Usually, when you tell a well-constructed story, you don’t start with what happened
until you establish where, when, and in what climate or atmosphere it takes place.
This sets a mood. It prepares the viewers for an emotional reaction you are trying to
get them to feel, so that as the story is told, they identify with your characters.
Hopefully your viewers will get so emotionally involved with the characters that they
feel fear or joy, just as the characters do. When telling a story with pictures, this is
called an establishing shot (or group of shots). Let your viewers know where and under
what conditions the story begins. When telling stories that jump from place to place,
it’s often a good idea to use at least one shot that tells the viewers where you’ve taken
them so that they are emotionally set up to participate.

Another thing to think about with a group of establishing shots is that each one
should build on the next. Each shot should tell the viewers a little more about the set-
ting of your story or scene. “The Midnight Sun” takes place in an incredibly cold
place, and it involves death, struggle, and promises made and kept. It sounds sort of
sad, lonely, serious, and tragic. Actually, this movie is a comedy! Like a great joke, this
movie needs to be set up so that the viewer thinks we are going in one direction
when in fact we end up in quite another.

An editor’s job is to get the audience to participate emotionally with the story. That’s
what keeps them involved and entertained. If you present them with an edit that mis-
uses the language of motion pictures or that makes the audience aware that they are
being emotionally manipulated, you lose them. They get bored; they turn off the
movie or go to the snack bar. In artistic and even financial terms, this loss of interest
spells disaster. If the audience loses interest in your TV spot, you don’t sell product. If
they lose interest in your instructional video or documentary film, they don’t learn,
and they don’t become productive with new knowledge. When they don’t get
involved with your story, they don’t recommend your movie to another potential
moviegoer.

When editing a narrative film like “The Midnight Sun,” another important technique
to employ is what I call “organic editing.” These motivated edits feel natural to the
viewer because they are much like what the viewers would be motivated to look at if
they were watching the scene in real life. The actors usually establish a rhythm for a
scene; this can be enhanced by the editor’s edit decisions. As you edit a story, you’ll
find that the story contains a beat, just as if it were a piece of music. Actually, there is
a rhythm to everything in life. We like rhythm. It reminds us of the most comforting
time of our existence—the time when all we had to do all day was listen to our moth-
er’s heartbeat. Each of us has an internal clock as well. Its tempo differs from person
to person. Your edit decisions sometimes reflect your personality. Some folks talk really
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fast, and others don’t. But when you include a beat between speeches, for example,
that character’s own rhythm should be reflected in the amount of time you choose to
use as a beat between lines. A character’s rhythm also reveals itself in the speed
between different actions he or she performs.

Think of your own heartbeat and what happens to it when you’re scared (or feeling any
emotion, actually). A chase scene might excite you enough to make your heart start rac-
ing. Reflecting this, you might choose to show cuts of shorter and shorter duration to
reflect the emotions onscreen. Put yourself in these emotional moments, and your own
personality will begin to show through the edit decisions you make. When you get
excited, the edits come faster, and when you relax, they slow down, but only within the
context of the story at any given time. Don’t show a single frame the audience doesn’t
need to see, and do show all the frames they must see to understand the story each
shot has to tell. After it has been told, get off the shot. Don’t bore the audience with
redundancies or information that doesn’t have much to do with the story being told.
Just because it’s a pretty shot doesn’t mean it adds to the story.

To perform an edit that keeps the viewer involved, start by organizing what the director
has shot. If you can’t find a certain shot (or worse, you aren’t even aware of it), you can’t
use it effectively when you get to where it should be in your sequence. Just breaking long
clips into smaller bites also helps familiarize you with the footage, and that leads to better
edit decisions. You don’t want any of the footage to be “out of sight, out of mind.”

Setting In Points and Out Points
You can set an In point in the Viewer, Canvas, or Timeline window by clicking the
appropriate button under the Viewer (if you are setting a source clip’s starting point)
or the Canvas and Timeline (if you are setting where it starts in the sequence). Out
points are set the same way, with the respective Mark Out buttons in the Viewer or
Canvas. The keyboard shortcuts are the best way to set In and Out points in the
Viewer, Canvas, or Timeline. Press I for in and O for out. The I and O keys are right
above the J, K, and L keys, used to shuttle the video in all three windows. You should
get into the habit of using these five keys to move, mark, and creep through the
footage (L or J +K) to mark your In and Out points most of the time. If you have time-
code numbers, such as those given for the Workshops in this book, you can either
type them in or get used to using the J, K, and L keys to shuttle to them. Also don’t
forget that pressing the J or L key more than once speeds up the shuttling process 
(L for play and J for reverse). By pressing the left or right arrow key, you can go
through your footage backward or forward a frame at a time to locate just the right
frame at which to set an In or Out point.
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You can’t set more than one In point or Out point in the Viewer unless the source
material contains audio and video. If the clip contains more than one track of media,
you can perform split edits. With split edits, multiple-track source clips (such as
sound sync audio and video clips) are marked so that the audio and video are edited
into your sequence at different times. For example, you show the video and then add
the audio a bit later, or you hear the audio before the video that syncs with it.

However, there’s a way to perform split edits more intuitively. First, you cut the audio
track the way you want to hear it using audio/video cuts along the way (it helps to
set your timing and the scene’s rhythm too). After you have performed this rough
cut, unlink the synchronized audio from the video clip it’s associated with by 
pressing the unlink button in the upper-right corner of the Timeline window or 
by pressing Shift+L. Then perform roll edits on the video track. Roll to the left or
right. The split edit then gets performed in this manner. An even faster way is to use
the Roll edit tool while holding down the Option key. This temporarily unlinks the
video clips from their linked audio.

Making Subclips and Their Properties
You can make subclips from any sort of clip, including other subclips. The idea is to
spend no more time than necessary to locate a specific shot or moment in what
could possibly be an entire tape’s clip. In other words, if you find it once, finding it
again is a snap.

After you open Project 1, supplied on the DVD, you see that two of the three video
clips currently in the Browser window have disclosure triangles next to their names.
If you click one of them, it opens to show you the markers I’ve placed in them.
Markers in this case are used to begin the sorting of all the footage that was shot for
“The Midnight Sun.”

You don’t have to pause to set an In or Out point. You can set it as you play the
video or audio in either the Viewer or the Canvas. You can continually press I to
update the Mark In point or keep pressing the O key to keep updating the Mark Out

point as you watch the video. Each time you press I or O while you watch the video, the new
point gets set. This is great for getting a quick update or making a change as you watch the video
play. A constant updating of the In or Out points really helps move your editing along. This works
well when you don’t know exactly where a pan might end or a zoom or dolly might end or start.
It also helps you set the pacing and timing of edits (finding the rhythm of the beats, as mentioned
in the sidebar). In the case of an interview, it’s great to update an Out point when the next sen-
tence is finished. As soon as you start setting points this way, you’ll see the advantages. Try it.
You’ll like it.
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If you double-click one of these clip markers, the footage marked between the posi-
tion of the marker and the next marker opens in the Viewer window. You can actu-
ally edit from this portion of the master clip (the original captured video clip that the
marked footage is a part of). But you’d still have to sort through a lot of names and
open and close the master clips to locate the footage. It’s still not as efficient as it
could be. The markers are still really a part of a master clip organizationally. Also, in
most cases, not all of the clips for a specific scene are together. So to work on a given
scene, you still have to sort through a lot of clips to find the appropriate one.

You can turn these markers into a subclip and drag and drop this subclip into bins
you’ve created to further organize the footage. The clip named “3 hr timecode 
section” contains no markers, so it doesn’t have a disclosure triangle next to its name.
You’ll create subclips and markers in this chapter’s Workshop and finish the job.

To mark a subclip without using markers, set an In point where you want the subclip
to begin, and set an Out point where you want it to end. Then select Modify, Make
Subclip, or press Cmd+U. The subclip is created in the same bin that the master clip it was
created from resides in. If you make a mistake with a subclip, simply highlight its icon
in the Browser and press the Delete key to start over, or drag it to the bin it should
be in. Again, you are making reference or pointer files; you aren’t deleting any media.

A problem can arise later if you don’t plan ahead as you make edits. The same prob-
lem arises if you make edits using marked clips. Final Cut Pro assumes that there is
no media on either side of the start point or end point you used when you created a
subclip. It’s treated as its own capture (media file) from tape and not as part of the
“real” media file it was taken from, which might indeed have frames before and after
it. If you can’t lengthen or create a transitional effect such as a dissolve between two
shots because you used this subclip in your sequence, highlight it in the sequence
and choose Modify, Remove Subclip Limits. This releases Final Cut Pro to use the
frames before or after those contained in the subclip.

Limiting media file access might seem awkward, but it has a definite benefit. If you
make subclips a bit on the “fat” side, meaning that you subclip all the possibly usable
footage even if you think or know you won’t use it, removing subclip limits then usu-

ally becomes a nonissue, because you wouldn’t want to use media past what you’ve marked. The
benefit is that this method of “fat” subclipping also lets you know later you can’t use the media
before or after the subclip because it would cause a camera’s cut (the take before or after the cur-
rent subclip) to show up in the middle of a transitional effect—something you want to avoid.

In other words, when you edit from a subclip to your sequence, you run the risk of not being able to
apply a transitional effect (such as a dissolve between two shots) where you want to if you created a
subclip with only the footage you think you want to use in your sequence. In most cases, don’t use
subclipping to set your actual edit points; go “fat” and subclip the entire bit of footage that relates
to a particular shot or take. If you are subclipping from a slate, which is an ideal way to shoot in prepa-
ration for logging, start with the slate and end when the camera cuts or even at the beginning of the
next slate, not before and not after. You’ll never want to show a slate in a scene, so subclipping from
slate to slate will never set up a situation where you need to remove subclip limits.
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Alternative Methods of Organizing Material
There are alternative ways to break down material for quicker access. For example,
you can place it in the Viewer, set In and Out points, and drag it from the Viewer to
the Browser. The benefit is that you don’t have to worry about removing subclip lim-
its if you edit from these “subclips.” They allow you to access certain shots quicker
than just searching long clips, and you can rename them as well. But they are not
true subclips; they are copies of your master clip with In and Out points. The use of
the scrubber bar becomes more problematic, because it is tougher to scroll within
objects created this way, especially if it’s a short subclip contained in a very long
source clip. If you use the method described in the Tip, you gain the ability to scrub
more efficiently, and you won’t be bothered with removing subclip limits.

There is another negative thing about organizing using any other method. Methods
other than creating true subclips leave items with the wrong icons—master clip
icons. You never want confusion about this. If clips have similar names, they could
be confused with master clips.

When you make subclips from subclips, you retain the ability to see a proper icon.
Removing subclip limits also allows this new subclip to access all the media associ-
ated with the original medium of the capture it’s contained in, not just the media
from its original subclip.

Workshop 4: Organize and Begin Picking Shots
Final Cut Pro contains a set of tools that help you get organized and break
down your source material to group related clips. Sorting the material saves
you a lot of time during the edit and reacquaints you with the material. The
Browser is where source material is organized.

1. Open Project 1. You will preserve this original project file and create another 
one for your own use. That way, you can always start over if you need to without
reloading everything from the DVD. Select File, Save Project As. Type FCP
Project 1 “your name” in the Save As: field. It’s OK to put this file in the same
folder as the original, or you can put it in a new folder, as shown in Figure 4.4.
Keep this file on your startup disk, not your media disk (if you have one).
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FIGURE 4.4 The Save dialog box.

2. Click the triangle next to the Picture Clips bin in the Browser. It opens, and 
its contents are revealed, as shown in Figure 4.5. Double-click the Picture Clips bin’s
folder to open it in its own window, as shown in Figure 4.6. This also closes the bin in
the project window. Arrange this new window to the side of the Browser window if
it’s not already there so that you can see its tab and the other tabs in the Browser at
the same time and so that clicking either does not hide the other. Drag the tab near
the top of the Picture Clips bin to the area where the FCP Project 1 and Effects tabs
are. The bin’s tab should now be part of a set of three tabs contained in the Browser,
as shown in Figure 4.7. Clicking a tab is a quick way to get to a particular bin. If you
Option-click a bin, it opens as a tab in the Browser.

If you have 30 or 40 bins, this might save you a lot of time searching for the one
or two bins you are currently using. Leave it open for now, but to close the tab in
the Browser, Ctrl-click the tab and choose Close Tab. You can also put bins inside
bins. Let’s say you have a set of bins broken into scenes. Within these scenes are
clips of an on-camera host and shots to illustrate the points the speaker is talking
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FIGURE 4.5 Opening a bin with the disclosure triangle.

about (these shots are often called b-roll). You could keep the host in the scene
bin in another bin created inside the scene bin and the b-roll shots in another.
The more organized you are, the easier and quicker it is to make edit decisions.
Also, you’re less likely to miss a really wonderful edit because you forgot about
that special element or couldn’t find it.

05 2816_CH04  9/30/03  3:14 PM  Page 118



Chapter 4: Organization and Basic Editing 119

FIGURE 4.6 The open bin window.
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FIGURE 4.7 The quick access tab.

3. Click the FCP Project 1 tab. Create a new bin in it by selecting File, New, Bin 
or by pressing Cmd+B. Notice that the bin’s name is highlighted and ready to
change, as shown in Figure 4.8. You don’t need to delete the old name; just start
typing. Type Scene 1 and Press Enter. You’ll look for opening or “establishing”
shots to set the movie’s mood.

05 2816_CH04  9/30/03  3:14 PM  Page 120



Chapter 4: Organization and Basic Editing 121

FIGURE 4.8 Renaming bins.

4. Open the Picture Clips bin and click the disclosure triangle next to “2 hr timecode
section.” You see the markers I’ve placed there for you. Highlight the marker
named Abandoned Rags and press Cmd+U. A new subclip with the same name 
is created in the Picture Clips bin. It might be out of view, so scroll down to find
this new subclip.

5. Drag the tab in the Browser of the Picture Clips bin to the side so that it opens 
in a second window and reveals the rest of the Browser’s contents in the first 
window. Then drag this new subclip, named “Abandoned Rags from ‘2 hr time-
code section’ Subclip,” to the Scene 1 bin in the first window. Clicking the 
disclosure triangle next to the Scene 1 bin reveals that the subclip is now there, 
as shown in Figure 4.9. Notice its serrated clip icon.
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FIGURE 4.9 The Scene 1 bin containing a new subclip.

6. Let’s do another subclip from marker creation. Open the “1 hr timecode section”
disclosure triangle by clicking it, and reveal the markers contained in it. Locate
the marker named “Cap up mtn side dusk,” which starts at 1:13:03:22, and press
Cmd+U. Then drag this new subclip to the Scene 1 bin.

The source footage from the film transfer used throughout this book is nondrop
frame timecode. Also note that none of the film transfers have any audio tracks.
Sync sound can’t be recorded to the film. For what little sync sound is used in 
the film, you’ll have audio files that were created from the Nagra that recorded 
the sound.

7. Drag the “Cap up mtn side dusk” marker from the Scene 1 bin to the Viewer, or
simply double-click it. Either way, it opens there. The reason to use this copy is
that you will create subclips from it. They will appear in the Scene 1 bin as you
make them, not in the Picture Clips bin, where I find it convenient to store all
master clips. Subclips are created in the same bin in which the clips or subclips
they are created from reside. You are primarily looking for establishing shots for
the opening of the movie.

8. Click the Play button in the Viewer. You see a few false starts, and then two takes
of Cap pulling Sam’s body up a hill, followed by some scenic long shots of snow-
covered mountains. The most vivid color in these shots is the sky behind the
mountains in Cap’s takes, but unfortunately there is not much footage in this
shot without Cap walking through it. These were the only long shots taken for an
establishing shot for the story, so you’ll use a frame of Cap’s background without
Cap in it and freeze it.

I rather like the balance of the frame at 01:14:04;04. Click the time-code display
in the upper right of the Viewer, type 1140404 in the time-code display box, and
press Enter. The Viewer displays that frame. There’s no need to type the colons,
the semicolons, or the first 0. Final Cut Pro adds 0s to the beginning of any 
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time-code numbers so that they contain a total of eight numbers, which all 
time-code numbers contain. If you typed 1000, the Viewer would display 
code at 00:00:10;00 (as long as that time-code number is in the clip you are 
navigating with).

9. Select Modify, Make Freeze Frame or press Shift+N. A freeze frame with this back-
ground is created, with a default duration of 10 seconds from its In point to its
Out point. This duration is as it was set in the General tab of the User Preferences
window. This freeze’s full duration is 2 minutes. Open the Scene 1 bin by double-
clicking it. Click and drag the clip from the center of the Viewer back to the Scene
1 bin. (Drag it to the Name column.) As you drag, you see a ghosted version of
the clip drag with the mouse. When you let go, a graphic clip is saved in your 
bin that is this freeze frame, as shown in Figure 4.10. Notice that the frame’s 
timecode number becomes part of its name, and it has a new icon, indicating that
it is a graphic file, as shown in Figure 4.11.

FIGURE 4.10 Dragging a clip from the Viewer.
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FIGURE 4.11 A freeze frame clip after being dragged from the Viewer.

10. Click the recent clips list in the lower-right corner of the Viewer, and select “Cap
up mtn side dusk from ‘1 hr timecode section’ Subclip,” as shown in Figure 4.12.
It reappears in the Viewer. Scroll through it to 1:14:33;14 and mark an In point.
Either click the Mark In button or press I. Then click the Play button or press L
until the end of this particular shot. Set an Out point there. This time, instead of
dragging, choose Modify, Make Subclip or press Cmd+U. A subclip appears in the
Scene 1 bin, ready to rename. Type Pan of Mountains. Double-click this new
subclip’s icon. The subclip opens in the Viewer. You’ll find that it contains only
the footage you selected.

FIGURE 4.12 The Recent Clips shortcut menu.

11. Take a look at the Pan of Mountains subclip. Reload the “Cap up mtn side dusk”
subclip into the Viewer, but do it this time by highlighting the Scene 1 bin and
using the up or down arrow keys to navigate to it. Highlight “Cap up mtn side
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dusk from ‘1 hr timecode section’ Subclip” and press Enter. The subclip reopens in
the Viewer. There is a way to keep your hands on the keyboard instead of going
back and forth between it and the mouse. If you type Cmd+4 to activate the
Browser, you can navigate to any item in the Browser by using the four arrow keys
to do so. The up and down keys do what you’d expect, and the right and left arrow
keys will open an item with a disclosure triangle to navigate down or up through
its contents. You may find you can navigate very fast this way. Where the position
indicator (or playhead) is sitting is where you’ll mark an In or an Out point if you
press I or O. The Viewer must be the active window if you press L for play (or the
spacebar, which also toggles play on and off), K for stop, or J to play backward.
Holding down the K key and then holding down either the L key or J key plays a
clip slowly. The right and left arrow keys advance or step forward and backward
through a clip one frame at a time for precise movements. Using the mouse for 
this works too, but in the long haul it takes more time to get to exactly where you
want to go.

12. Try the different methods of marking and creating subclips and navigating in 
the Viewer to find the In and Out points. I think you’ll find that you will become
more efficient using the keyboard commands to mark In, mark Out, and create
the subclip. You can also drag the position indicator to scroll through the clip.
Normally, you would subclip the two takes of Cap’s walk up the hill, but later
we’ll edit the section that contains this shot as a pre-edited scene. When you get
done trying things on your own, delete any subclips you’ve created so that your
Scene 1 bin contains only the same clips as Figure 4.13. Just highlight any subclip
and press the delete key to delete it.

FIGURE 4.13 The first four items.

13. Create three more subclips of the shots that follow the last subclip the same way
as earlier and name them Mountains 1, 2, and 3. When you are done, you should
have a bin that contains the same six clips shown in Figure 4.14. When you are
finished, delete the “Cap up mtn side dusk” subclip from the Scene 1 bin. (Be sure
not to delete the freeze frame.) Don’t worry; you still can access it from the
Picture Clips bin. (There will be less to sort through later in the Scene 1 bin.)
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FIGURE 4.14 The first six items.

Work with the Button List, Button Bar, and Keyboard Layout
1. Press Opt+J to open the button list, or navigate to the Tools menu and select it

from there. Then open the Modify menu’s disclosure triangle by clicking it.

2. At the top of the list is the Make Subclip icon. Drag it to the button bar in the
Browser, as shown in Figure 4.15.

FIGURE 4.15 Dragging a button from the button list to the Browser’s button bar.

05 2816_CH04  9/30/03  3:14 PM  Page 126



Chapter 4: Organization and Basic Editing 127

3. Ctrl-click the newly placed button, and change its color.

4. While you’re here, take a close look at the button list. This is the same list that
opens with the Keyboard Layout window. Note the organization of this enormous
list of buttons. The menus across the top of Final Cut Pro 4’s interface are repeated
here, as are the commands on the pull-down menus.

5. Open the keyboard layout by pressing Opt+H or by navigating to it using the
Tools menu. The button list closes, and the default keyboard layout opens. Click
the cmd tab to reveal the default keyboard layout when the Command key is
used. Note that Cmd+U is the default setting for the Modify, Make Subclip 
command.

6. Click the lock button in the lower left of the Keyboard Layout window to unlock
it. Take some time to drag buttons from the list on the right and drop them on
the keyboard so that you get a feel for how this works. When you are done, click
the Reset button in the keyboard layout to reset the layout to the default settings
for now. As soon as you get a handle on tasks you often perform (especially those
with no default keyboard equivalent), you’ll know when it’s time to either learn a
default keyboard shortcut or map a button to the keyboard or a button bar to ease
your workflow. It will be when you navigate to a menu item repeatedly. When
you are done experimenting and you’ve reset the keyboard layout to its default,
close the Keyboard Layout window by clicking the close button in the top-right
corner.

Discover Marker Shortcuts and Begin Working with Markers
1. Navigate to the Picture Clips bin and double-click the “1 hr timecode section”

master clip to load it into the Viewer.

2. Press the Home key to bring the playhead to the first frame of the clip in the
Viewer.

3. Press Shift+M to jump to the first marker. Pressing Shift+M repeatedly moves the
playhead from marker to marker. Try this.

4. Press Opt+M to move the next marker earlier in the clip. Obviously, you could
just edit from here, but your clip names in the Timeline would all be named the
same as this master clip. This would be very inefficient later. Therefore, you’ll con-
tinue to create subclips from these markers.

5. Open the “3 hr timecode section” master clip in the Viewer by double-clicking it.
You’ll create your own set of markers for this clip. To create one, you need to
move the playhead to the starting frame of the marker by pressing M twice. A 
dialog box opens, allowing you to name the marker. (This name will also be used
in the subclip you’ll create from the markers.)
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6. Navigate to 03:00:02:00, press M twice, name the subclip “Sam Asks Cap for
Cremation tk 1 Pan,” and press Enter. You see a marker in the scrubber bar and 
a disclosure triangle next to the master clip in the Picture Clips bin. Click the 
disclosure triangle next to the master clip’s name to reveal the list of markers. 
You can change a marker’s name if you need to by clicking it.

7. Next, using the following log, create a marker at each time-code number in the
list, and name them accordingly. Don’t deviate, because the way this works as
you edit these clips depends on the exact positions of the subclips you’ll end 
up creating.

Sam Asks Cap for Cremation tk 2 Pan 03:01:21;10  

CU Sam looking at picture 03:02:38;15  

CU over shoulder of Picture 03:03:00;14  

Unusable footage 03:03:27;21  

Wide angle Cap lights match in snow 03:03:35;28  

CU Cap lights match in snow tk 1 03:04:34;28  

CU Cap lights match in snow tk 2 03:04:44;26  

Reverse Cap lights match in snow tk 1 03:05:09;25  

Reverse Cap lights match in snow tk 2 03:05:29;22  

Dog footage 03:06:07;04  

Med shot Cap reverse on sled 03:10:58;14  

CU Dog 03:11:33;03  

Cap pulls body over ridge of snow 03:11:53;29  

Dogs under trees resting 03:12:34;17  

Cap looks at smoke tk 1 03:13:29;20  

CU Lake Labarge Sign 03:13:45;27  

Smoke coming from behind hill 03:13:56;26  

Smoke bkg 1 03:14:12;06  

Cap walks away LS 03:14:27;09 

When you are done, opening the “3 hr timecode section” clip in the Picture
Clips bin looks like Figure 4.16.
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FIGURE 4.16 The Picture Clips bin after you place the markers for “3 hr timecode section.”

8. Navigate to the Picture Clips bin. Open the marker named Lone Cross contained
in the “1 hr timecode section” master clip in the Viewer by highlighting it and
pressing Enter. Play the clip. Because it contains only this one shot, activate the
Browser, make sure the Lone Cross marker is highlighted, and click the newly
placed Subclip button in the Browser’s button bar. Drag the new subclip to the
Scene 1 bin.

As explained in Chapter 3, these are reference files. They can also be thought of as
aliases to a media file and, in this case, a portion of the actual media file. You did-
n’t copy the media file; you created another pointer clip to it. Also keep in mind
that each copy of a new clip is an independent reference to the media file it
points to. If you change a clip, such as by setting an In point or Out point, any
other clip that references this same media will not reflect the change you made in
the first clip. Also be warned that if you delete the media associated with one of
these matching clips, you delete the media to all these subclips and the master
clip they were subclipped from.

9. Navigate back to the Picture Clips bin, and load the Dog footage marker in the “3
hr timecode section” clip into the Viewer. Create a subclip of the shot, and drag it
into the Scene 1 bin.
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10. Locate the Map Footage marker in the “2 hr timecode section” clip in the Picture
Clips bin. Open this marker in the Viewer, and play it. This marker contains 
several shots, so we’ll break it down. Create a subclip of the Map Footage marker,
and drag it to the Scene 1 bin.

11. Double-click the new Map Footage subclip to open it in the Viewer.

12. Create subclips of the four shots contained in this subclip. Set an In point at
02:08:43;08, and mark an Out point at 02:08:59;04. Highlight the subclip in the
Browser, and press Cmd+U or click the Viewer’s button bar’s Make Subclip button.
The new subclip appears in the Scene 1 bin. Name this subclip “Reverse Cap and
Sam look over the hill LS” (LS stands for long shot). The second subclip runs from
02:09:00;07 to 02:09:10;14. Name the second subclip “Cap walks through snow
CU” (CU stands for close-up). The third subclip runs from 02:09:11;11 to
02:09:38:24. Name it “Cap and Sam look over the hill FS” (FS stands for full shot).
The last subclip runs from 02:09:38;27 to the end of the shot at 02:09:55;23.
Name this last clip “Cap looks at map CU.” Delete the “Map Footage” subclip in
the Scene 1 bin. It’s been broken down further anyway, so you don’t need it any
longer.

13. Double-check your work. Your Scene 1 bin should contain the same clips as
shown in Figure 4.17. Save the project by pressing Cmd+S. You can’t save too
often. I’ll prompt you once in a while, but it’s wise to save often and back up
your project file to a medium not on your computer, such as a CD or Zip disc, 
at least at the end of each editing session.

FIGURE 4.17 The first 12 items.
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